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July Meeting

Scott Randell

For July’s meeting (Friday 7/8/11) I did the presentation, which
was on PDFpen and PDFpenPro (from Smile Software). During
the presentation a great many people were asking questions, some
of which took me a while to answer, and some I was not able to
answer at the time. The result of this was I was not able to demonstrate all that I had planned. In this article I will give accurate
answers to all of those questions, and give a description of the features I was not able to get to.
Most of you know how to create a PDF from another file. For
example, in Pages you would use the File menu’s Export or the
Print command. You could then open that PDF in PDFpen by
right or control-clicking or dragging over the PDFpen icon. To
streamline this process, PDFpen provides a shortcut. First from
the PDFpen menu select “Install PDF Workflow”. (See Screen
Shot-1.) Quit PDFpen and Pages, when you reopen Pages, select
and open your document again. This time go to File --> Print (or
command-P), click on the PDF button, and you will see the new
choice of “Open with PDFpen.sh”, (see Screen Shot-2) select it
and the document will open directly in PDFpen.
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August Meeting

Bradley Dichter

LIMac is pleased to bring back Bradley,
with a presentation on the hot topic of the
month, Mac OS X 10.7 Lion. (Get it? August
AUGUST
- hot topic!) You’ve probably been reading
about the recent (July 21) availability of Lion
as an upgrade from Snow Leopard 10.6.6 to
10.6.8 or the new MacBook Air and Mac
mini models that come with the Lion preinstalled. Other Mac models today come
with Snow Leopard, but the OS X Lion Up-To-Date Program
offers the upgrade for free if you bought your Mac from June
6 or later. It’s $29.99 for the rest of us with not quite so new
Macs. You get it via the App Store app you got when you upgraded to Mac OS 10.6.6 back in January. It’s about a 4GB download, so anyone running a slow DSL connection is going to have
to be patient. Anybody with a Intel based Mac with just 1GB of
RAM or the first gen Intel models with Core Duo and not Core
2 Duo cannot get Lion, as are any of the older PowerPC based
Macs as they couldn’t even be running Snow Leopard in the first
place. Some of the new Lion features like AirDrop require even
newer models. See http://www.apple.com/macosx/specs.html for
details. Generally you need a Apple ID to use the Mac App Store,
but because of that, the Lion upgrade is good for all 5 of your
home computers you can use that Apple ID with. Offices with
more Macs need to check out Apple’s Software Volume Licensing.
So why would anyone want a newer operating system in the
first place? Apple likes to boast about it’s 250 new features. How
many do I care about? If you ask me, not many. If you use a laptop’s TrackPad or the new wireless MagicTrackpad with a desk-
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top Mac, then there are some new gestures.
I don’t and the only gesture I do make use
of is the scrolling one, so I don’t count this
as a big plus. In fact the scrolling is backwards from what we Mac users are used to.
It’s like the iOS way of doing things. I install the free Scroll Reverser 1.3 to get things
working like I’ve been used to for 27 years.
Then Apple likes to highlight Full-Screen
Apps. Another bad idea for me anyway. If
an application takes over my whole 30˝ display, I can’t keep an eye on other things
and I can’t drag and drop stuff from one
to the other. It would kill my productivity. As I was writing this, a notification window popped up, which needed attention
in 16 seconds, which I would have missed
if InDesign CS5 was taking over my whole
screen. Now if I was constrained to using
a 11˝ MacBook Air which only has 1366
x 768 or a 13˝ MacBook Pro which has
1280 x 800, and either with limited RAM,
I probably would like full screen apps, as I
could only work on one at a time and need
every pixel at my disposal. Related to that
is Mission Control, another waste of time.
It’s like the iPad screen, showing me my
apps and Dashboard widgets. It’s like Exposé and Spaces joined, neither of which I use,
particularly as I have a big enough monitor
or two and many programs would crash if
I enabled Spaces. Similarly the iPad influence continues with LaunchPad, which ignores the Dock and Finder windows and
gives me the iPad home screen. My Mac is
not equipped with a touch screen, I don’t
want to join apps into little icons grouping things together like I’m forced to under
iOS. I have a Mac, don’t take it away from
me and leave me with a 120 pound iPad.
So here we come to a few positive new

features: Resume, which opens programs
back to the state you left them when you
quit. Now some programs already do this
and other programs will have to be rewritten to take advantage of this, so I don’t really count this as a gift from Apple. Just Apple encouraging them to add this function.
Probably not a good idea if my program
closed because it crashed. Resuming would
probably cause it to crash again, an infuriating loop I can’t get out of, unless I kill the
Resume function.
Then there is the new Auto Save and Versions. These can be handy way to to extend
the Time Machine concept. Instead of backing up your whole Mac every hour, Auto
Save wants to back up your current work every 5 minutes so in case you screw up working on your document or you cheaped out
and didn’t buy a battery backup for your
desktop Mac, you can use the companion
Versions interface, very much like Time Machine’s, to restore your document to a previous state. I wonder how much this will slow
down my computer and how much disk
space it will use? Still probably a good thing.
Good thing I just got a 3TB hard drive.
I don’t have enough space here in the Forum, nor will I have time at the meeting to
cover all the new features in Lion. Check
them out here: http://www.apple.com/macosx/whats-new/features.html
I did want to draw your attention to a few
items, like Picture-in-picture zoom, AirDrop for making file sharing even easier,
the new Day view in iCal, Lion Recovery
partition of my hard drive, so I can recover with Time Machine when I can’t find my
DVD as Lion doesn’t come with one. The
new Conversations view in Mail, it may not
be well done, but it works. Seems Apple
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does copy a couple of things from Micro- out in 2006, but there are some popusoft, in this case Outlook. And that includes lar programs we used to use before we insupporting the year old Microsoft Exchange stalled Lion. Most noteworthy would be
2010. A little tidbit that’s nice is the new Pre- AppleWorks 6.2.9 and Quicken 2007r3. Inview supports iWork files now too.
tuit offers Quicken Essentials which can imThe new Safari 5.1 which is also available port the data from Quicken. I’d set that up
for Snow Leopard adds some nice features. before you upgrade to Lion. The interface
It also breaks a few old ones, but that’s par is different and there are far fewer features
for the course. The new Sandboxing func- that some have gotten used to and need. If
tion should make things more stable. It’s you own iWork ‘09, then Pages can open
that a terrible name? I really hate the new AppleWorks WP format files and Numdownloads function. I want my separate bers can open AppleWorks SS format files.
window back.
The problem is there is no way the Finder
The new Migration Assistant now sup- can show you which is which. They both
ports copying files from a networked Win- should have a .cwk file name extension.
dows machine, so that should make switch- AppleWorks still saves the files with the obing over a lot easier. I also do like the new solete Finder metadata of TYPE and CRESystem Profiler.
ATOR codes. Type CWWP for word proOK, so what won’t you like? While I can cessing files and CWSS for spreadsheets.
resize a window from any edge or corner, Snow Leopard has no way of searching for
the Finder no longer offers the simplified this information. I found that HoudahSpot
view that allows me to open a new window still can, so you could drag all your WP
with a folder’s contents, so I can drag files files to one folder and your SS files to anaround to where I need them to be.
other. Then you can drag a batch of say the
The system also by default makes the WP files onto Pages’ icon, opening each in
home folder’s Library folder hidden like it’s own window. You can then close each
several other folders. I needed to get in and save changes, creating a .pages file for
there to allow Mail to import my old mes- each. I don’t think Pages would care for
sages without crashing. I used the go to opening more than a couple dozen files at
Folder function but that’s not intuitive, cer- once, so do this procedure in small batchtainly not good for most non-technical us- es. Another option is you could, in advance
ers. I had to use a Terminal command to of installing Lion, open each AppleWorks
make it visible. I needed also to get in there file and save them in another format, like
to mess around with Preference Panes and Microsoft Word’s older .doc format and MiApplication Support folders. I have a pretty crosoft Excel’s .xls format, and then use Micomplex setup with hundreds of apps.
crosoft Office 2011 under Snow Leopard and
This brings me to the final caveat about Lion to work on the documents in the fuLion. They dropped Rosetta, that part of ture.
Tiger, Leopard and Snow Leopard that alThe older Office versions won’t work
lowed the Intel processor to run PowerPC right under Lion. Even then, Office 2011
coded applications. Now that drops off the will probably need an update to work right
software designed for computers phased
August Meeting continued on Page 9
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Bradley’s Tech Session
Bradley Dichter
Technical Advisor
bdichter@optonline.net

| I have a iMac and I’m

having trouble printing
to a Epson printer wired to a MacBook
Pro? I get a message that the printer is
not online. I power cycle the printer and it
works again. My connection is via Airport.
Lately it’s been getting worse. Even if I
power cycle the MacBook Pro it doesn’t
want to print. The wireless router is not
near the iMac.
■ I’d say you probably have two issues
here. First off the MacBook Pro is going
to sleep so the print queue offered by
Printer Sharing goes offline. So change
your Energy Saver System Preference panel
to never allow the computer to sleep, but
you can allow the display to sleep. Turn off
the allow disks to sleep, turn on the wake
for network access and never close the lid,
which would put it to sleep. You can buy
the $9.50 SleepLess from ALXsoftware or
the free Caffeine from Lighthead Software
or InsomniaX from semaja2 Gadets to
prevent it from sleeping even with the lid
closed. The second maybe you different
versions of the printer driver on the two
machines. You may need to download the
latest from the Epson web site and install it
on both, double-check that printer sharing
is on at the MacBook Pro, delete the old
print queue and create a new one. Then do
the same on the iMac, creating a new print
queue for the shared printer. If you wireless signal is strong and steady, this should
do it. On the other hand, it’s possible the
problem is with the printer or it’s USB

connection. If so then the MacBook Pro
would also experience problems printing.
Somewhat related to that, if the printer
was off and the MacBook Pro tried to
print, it couldn’t of course and the print
queue would be stopped. Thus it and
the MacBook Pro would not be able to
print. Keep the print queue in the dock
to keep an eye on it when trouble arises.
Of course it would make more sense if the
immobile printer was directly connected
to the immobile iMac and let the portable
printer rely on print sharing. If you bought
a new printer, since the router is not near
the iMac, a wired network printer would
not work, but a wireless network printer
should be OK, assuming it’s within a
strong signal. Then you don’t have to rely
on another computer to do the sharing. If
you have a iPad or iPhone, then one of the
HP wireless printers that support AirPrint
would be a good choice. Some of them
offer network fax too. With PageSender
nor FAXstf Pro X not working in Lion,
and network fax is all the more valuable.

President’s Message
Bill Medlow
President
archbill@optonline.net

This is just a brief note as to why you should attend our August 2011
general meeting on Friday, Aug 12th. It is not because it is a fabulous
operating system that everyone is looking forward to, but because Brad will also tell
you where there are issues and what older software and hardware will not work with
Lion or not work very well with it. These will help you enjoy Lion and avoid the pit
falls. Enjoy the summer!
Bill

DAN DANGLO

| What Mac program would you recom-

mend to convert a .fla or .swf file to a
.mov for use in iMovie? The Flash file was
done on a PC.
■ Scott Randell recommends using
Handbrake 0.95 with the minor exception
that it creates a .m4v file, but iMovie likes
those. The .fla is a native Adobe Flash file,
so I’d use Flash Pro CS5.5 and export as a
movie from the File menu. You could ask
the person who created the file to export
it to some video format for you and maybe
just need QuickTime Player 7 to convert
Bradley’s Tech Session continued on Page 4
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Bradley’s Tech Session continued from Page 2

for your Mac based use. For .flv and .swf
files, try Macvide FlashVideo Converter.
It’s $99.95 MacUpdate.com users don’t
give it much love. I would suggest instead
EasyWMV from Patrice Bensoussan for the
.flv an .swf to make a .mp4 file. It’s more
likely to work and only costs $19.99. I used
to use VisualHub 1.35 from Techspansion.
That became FilmRedux from Confuzzled
Software. If all else fails, if you can play
the video, you can use a screen capture to
video program.

| How about removing watermarks from
video?
■ Not easy. I suppose you could overlay
your own image without transparency over
the watermark to sort of over-watermark
the video. The cheap way would be just
crop out the area, usually a lower corner.
iMovie ’08 or newer has a crop tool, so this
it’s not hard to do, but has to stay in the
proper aspect ratio. I did a quick Google
search and found this video that shows
you how to remove pretty well a watermark from video using Adobe After Effects.
Yeah I know, not a cheap program. Perhaps
you qualify for the $449 Student and
Teacher Edition of Adobe Creative Suite
5.5 Production Premium which includes
Flash Pro CS5.5

| Occasionally my Mac won’t wake from

sleep by moving my mouse nor pressing
a key, only pressing the power button on
the back. Is this something I have to live
with or can it be resolved?
■ It may not be easy to find. I have a
similar problem on my Mac. First check
out the easy things. If your keyboard and
mouse are bluetooth wireless like modern

iMacs are, check your System Preferences Bluetooth - click the Advanced… button
and make sure the option for “Allow
Bluetooth devices to wake this computer”
is checked. Try a wired mouse, as bluetooth can be flaky and it powers down
when the Mac goes to sleep, thus ignoring
your wireless input devices. I found this
resource regarding a couple of hacks to
force bluetooth to power up after wake.
http://www.tonymacx86.com/viewtopic.
php?f=7&t=7940 If your mouse/keyboard are wired, the problem could be
what software you were running when
you put the Mac to sleep. E-mail and
web browsers often cause this problem
as they are often doing something interactive all the time and they don’t want to
stop. As an experiment, try quitting these
before you put the Mac to sleep and see
if the problem goes away. Sometimes the
problem lies in something else that’s running all the time in the background, like a
antivirus program, a scanner driver or some
other drive protection program, maybe
like MacKeeper or CleanApp or TechTool
Protection. I’ve heard that the older version of MagicPrefs caused a problem like
this, but that’s for Apple’s latest wireless
mouse. Windows Live Mesh for Mac can
cause sleep problems too. Try a safe boot
and see if that resolves the problem. As
the problem is not all the time, you may
loose patience with this intrusive testing
which could take hours with no results
one way or the other. You could have some
external USB or FireWire device causing
the problem, or the driver for them, so
try booting with nothing but the mouse
and keyboard directly connected and see
if that makes a difference. Also your keyboard and mouse should plug directly into
THE
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the Mac, not through a hub. It could loose
the connection when your Mac’s USB goes
to sleep. You have to try to divide and
conquer whether the problem is software
or hardware. Try booting up with a test
user account. That helps divide whether
the software problem is user specific in a
home folder or in the general /Library
folder. Try running Repair Permissions
and Verify Disk in Disk Utility to see if it
can find anything wrong. You may give
in and just get in the habit of shutting
the machine off or just letting the display
sleep, but the Mac never, via the Energy
Saver System Preference panel. On some
machines, the problem is the screen fails
to wake up but the Mac does. You may try
this: in advance, make sure the option in
the Energy Saver System Preference panel
for “Allow power button to put the computer to sleep” is checked. So when you
want to wake up the computer and clicked
the mouse or hit a key, the CPU woke
up but not the display. So quickly press
the power button to put the Mac back
to sleep. Allow about 10 seconds for it to
actually go to sleep, press a button on the
keyboard and the computer and it’s screen
should come alive. Sometimes the iMac’s
firmware gets a bit funky, so I’d suggest
resetting the SMC. You do that by shutting down, pulling the power cord, press
the power button for five seconds, release,
plug it back in. That should reset the SMC.
You could also confirm the setting in your
System Preferences - Startup Disk. Your
hard drive should be highlighted.

lems. It can surely bring some and introduce new ones you didn’t have before. If
your problems before were with hardware
or a corrupted system software, then no. If
the problems were with 3rd party extensions and applications and corrupted files
then yes. In addition, if your extensions
were OK, but running with say Mac OS
10.4.x or 10.5.x, and you now plop them
into the assorted sub-folders into the root
and user Library folders of Mac OS 10.6.8
or 10.7 next month, they surely could
screw things up that were OK before. The
safest thing is not to migrate your apps
and home folder and use FireWire Target
Disk mode and manually copy your documents over, your music and photos and
install new applications and extensions
and leave behind all the garbage you’ve
accumulated over the years. Yes, that’s a
real pain, but if you were not running the
very latest of everything, your conversion
to a new operating system will be a nightmare. You could kernel panic as the new
Mac boots up. This also minimizes the
problems of file permissions if you don’t
use the exact same long and short user
name and password on the new machine
as the old. I use Migration Assistant all the
time for my steady clients as I move files
from one machine to the other, because I
keep them up to date. So generally there
is less change from one computer to the
other, except maybe more horsepower. If
you like, color the copied files red so you
know what is suspect.

| Does the Migration Assistant bring with

camcorder for use with Mac OS 10.4.11.
■ That would be iMovie ‘08 v7.1.4, the last
that worked with Tiger except I know you

it all the problems you may be having with
an old computer to the new computer?
■ I wouldn’t say it brings all the probAUGUST
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| I have a question about a cheap HD

Bradley’s Tech Session continued on Page 8

July Meeting continued from Page 1

Screen Shot-2

Once you have any PDF open in PDFpen, you can start to use its features and editing
tools. The sidebar allows you to zoom, rearrange pages, and even drag pages in, from
another open PDF. You can view your PDF as single pages or facing pages.
PDF’s are generally read-only, but PDFpen allows you to edit any text in the document. Naturally, if it is a document that you created, you can open it in the original application to edit it, if however, it is a document someone sent you, or one you downloaded from a website, you do not have that option. Now you can edit that PDF so it
can be suitable for your own use. To edit text;
1. Use the text select tool and highlight the text you want to edit:

Screen Shot-3

had some trouble managing the image. In experimenting at home, I found exporting
the image to one of smaller size made it more manageable.
Next I demonstrated using PDFpen, to fill in non-interactive forms. You can do this
in PDFpen, but not in Adobe Reader. You can also save the edited form. PDFpenPro,
gives you the ability to create you own interactive fillable forms, these forms will be
cross platform. You can include in your form:
• text fields
• check boxes
• radio buttons
• and, pull down menus.
With PDFpen you can also perform Optical Character Recognition (OCR) on a
scanned document. I didn’t get a chance to show this at the meeting, but I can tell
you, it works quite well. You can scan directly into PDFpen, or open a document that
has been scanned and saved. The OCR is among the most accurate I have seen. Simply
choose, File-->Import from Scanner (see Screen Shot-5) and a dialog box will appear
allowing you to choose a connected scanner, or any shared scanner (see Screen Shot-6).
You can also choose the file type for the imported document (see Screen Shot-7). If you
already have a scanned document, you can simply open it in PDFpen. Most of the time
PDFpen will ask you if you want to perform OCR on the document. If it doesn’t just
choose Edit-->OCR and it will begin. You might in some cases need to force the OCR,
in that case, hold down the Command and Option keys together and then choose Edit-> OCR.

Screen Shot-6

Screen Shot-5
2. Click on the Edit Text button in the Toolbar:

Screen Shot-4
3. The selected text is now editable.
The next thing I showed was editing images. You can select, edit, delete or replace any image in the PDF you are working on. Once you select the image, doubleclick on it, and image editing tools will appear. They should look familiar as they
are very similar to those found in iPhoto. You can change exposure, contrast, brightness etc. You can delete the image, and insert one of your own. Once inserted you
can resize and/or crop the image to fit the space you have. During the meeting I
July Meeting continued on Page 9
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User Group Offers
George Canellis
User Group Ambassador &
Vice President
gwc11713@optonline.net

Texting Dots stick to fingertips allowing you to
use touch screen phones and devices with
better accuracy. They’re a terrific solution
for avoiding germs or to simply hit the letter better on iPhones, iPads, GPS screens,
grocery store self check-out, ATM pads,
and more. 42 dots per pack. Usually
$14.99 retail, this Apple user group special reduces the price to $11.99 for a limited time only. Gift Cards & Promotional
Codes:
Buy a pack today: http://
tinyurl.com/6y73fak This offer is valid
through September 30, 2011.
Dolly Drive backs up your entire Mac in
the cloud using Time Machine, Apple’s
auto-archiving software that comes installed on every Mac computer. Named
Mac|Life’s “Best of Show” at Macworld
Expo 2011, this versatile application even
lets you create a bootable clone on a local
external drive for a complete, redundant,
all-in-one backup solution for Mac. Apple
user group members receive 20% off for
one year of Dolly Drive (data centers in
U.S. and Europe) which is available in sizes from 50 GB to 2 terabytes, starting at
$5 a month. Coupon code:
Backup today: www.dollydrive.com This
offer is valid through October 1, 2011.
The days of having a separate charger for
each of your electronic devices are over.
The IDAPT Universal Charger charges

up to four mobile devices simultaneously
through a simple system of quick-release
interchangeable tips. IDAPT cleans up
clutter, it’s easy to use and it’s eco friendly. The special Apple user group price is
$47.99, well below the regular price of
$59.99. Coupon Code:
Order
online: www.idaptweb.com This offer is
valid through August 31, 2011.
Fadigear is overstocked on the Audioglove, a case that amps up your iPhone
3GS or 4, and turns it into a hands-free
device. This case comes in 10 different
styles, and, with its bomb-proof sleek design, keeps you safe, seen and heard. The
two-piece iPhone Audioglove redirects
the sound towards the user, and amplifies it by 12db. Your iPhone becomes a
boom-box, a hands-free mobile office, a
film studio or a voice-controlled tool for
any app on the market. Fadigear also provides bicycle and car mounts, and a desktop stand that are on the cutting edge
of innovation in active techno gear for
your iPhone. The possibilities are endless with this limited-time user group offer. The usual price has been reduced 50%
to only $17.50 for the iPhone4 version,
and $12.50 for the iPhone 3G/3GS version. Coupon code:
Amp your
iPhone now: www.fadigear.com This offer
is valid through August 31, 2011.
iPads are sleek, but this design also makes
them difficult to hold. This has ended with the introduction of the Hand-eholder which is 100% made in the U.S.A.
This simple, yet innovative, design lets
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you securely and comfortably hold your
iPad; all while allowing for 360-degrees
of rotation. There are also related handsfree options including stands, clamps and
wall mounts. The Apple user group price
for the Hand-e-holder is $31.99, 20% below the regular price of $39.99. A six-position mini-stand is included for free. The
Hand-e-holder leg strap kit is also available for only $39.99, well below the regular price $49.99. Coupon Code:
Order online: www.handeholder.com
This offer is valid through September 19,
2011.
video2brain online courses feature HD
video, bookmarks, an easy-to-use interface, and high-quality exercise files. video2brain is the creator of the popular
Adobe Press Learn by Video series. For
questions about the following courses, contact mugdeal@video2brain.com:
Encore CS5 Power Workshop, Photoshop
Without Photographs, Photoshop for Video Editors: Power Workshop, and Photoshop CS5 Smart Objects Workshop, Getting
Started with Adobe Premiere Elements 9,
Photoshop Image Cleanup Workshop. Usually $29.99-$34.99 for these video2brain
online courses, this Apple user group offer reduces the price to $20.99-$24.49
for each of these six select videos. Coupon code:
Review and purchase:
http://www.video2brain.com/en/mugoffer
This offer is valid through July 31, 2011.
TechTool Pro 6 delivers total hardware diagnostics, drive repair and daily maintenance for your Mac. Single-click diagnostics scan critical hardware to identify
impending problems. SMART test any
internal ATA or SATA drive (includAUGUST
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ing internal SSD’s), repair corrupt volumes, clone drives for trouble-free recovery, optimize your Mac to keep it
running smoothly, plus monitor your local area network activity. TechTool Pro provides ongoing protection too, alerting
you when aberrant behavior is detected,
so you can maintain top performance on
your Mac every day. With a regular price
of $99.99, this special price exclusively for
Apple user group members is only $59.99.
Discount code:
Order TechTool Pro 6 here: www.micromat.com This offer is valid through August 31, 2011.
Too many passwords to remember? 1Password 3 for Mac is a password manager that
goes beyond simple password storage by
integrating directly with your web browser to automatically log you into websites,
enter credit card information, fill registration forms, and easily generate strong
passwords. As an Apple user group member, you are entitled to get the single user
1Password on the Mac for $29.99, well below the normal retail price of $39.99
($52.49 for the 5-user family version,
which is usually $69.99). You also get a
25% discount on everything in the Agile store. 1Password is separately available
for the iPhone or iPad ($9.99) and iPad/
iPhone combo ($14.99) from the Apple
iTunes Store. Get yours today:
MacTech Boot Camp is coming to a city
near you. Specifically designed for techs
and consultants who support home office, small-to-medium sized business
and home users, this full-day seminar is
User Group Offers continued on Page 7
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packed with back-to-back sessions. Presentations are based on MacTech Boot
Camp’s nationwide 2011 curriculum, and
delivered by experts in each region. These
are specifically designed not only to educate about best practices and techniques,
but also help participants think about
ways to improve business, network with
others, meet new people, and find new
tools. Apple user group members can register for $295, which is 40% off the regular registration price of $495, which includes lunch. Hurry, because openings
are still available for Boston, Los Angeles and Chicago. For details, head over
to:
This offer is valid
through August 31, 2011.
Over 100 ebook titles are now available from Apress Media LLC about Apple products. This discount applies to exciting, new iOS titles such as: Beginning
iPhone 4 Development: Exploring the iOS
SDK, The Business of iPhone & iPad App
Development: Making and Marketing
Apps that Succeed, and Pro Objective-C
Design Patterns for iOS. To browse Apress’ comprehensive line of iOS and Mac titles visit: http://www.apress.com/applemac Apple user group members receive an
exclusive 25% discount off on ANY Apress eBook. Simply enter the coupon code
upon checkout when purchasing your
ebook. Get your ebook version today
at: http://www.apress.com/ Checkout
code:
This offer is valid through August 31,
2011.
ASSERO iPad accessories provide a por-

table and protective way to carry your Apple iPad. The Defender provides a backor forward-facing design which permits
mobile hands-free iPad use with a comfortable, ergonomic design that allows
typing with both hands. With a signature mobile desktop, ASSERO’s 4-in-1
convertible backpacks are perfect for active, technology-savvy individuals. Highquality fabrics include mesh breathable
straps and backing, soft fleece-like interior fabric for ipad/screen protection, and
pockets for personal belongings. With a
regular price of $129.99, this special Apple user group price is $103.99. Promo
code:
Learn more and purchase: www.asseroindustries.com This offer is valid through September 1, 2011.
If you find the volume on your Mac too
low, Global Delight has the perfect app
for that. With just a click, the Boom Volume Booster not only amplifies the audio
of your system, but also enhances your experience while watching movies, listening to music, on a Skype call or listening to songs on your iPhone/iPod. With
a regular retail price of $8.99, the Apple
user group special price is only $4.99 for
this Macworld 2011 Best of Show winner. Coupon code:
Link to the Global Delight Online
Store: http://www.globaldelight.com/store
This offer is valid through December 31,
2011.
Disk Drill protects your files from accidental deletion with Recovery Vault and
recovers lost data from Mac disks. It features a number of advanced scanning
modes for data recovery of FAT, NTFS,

HFS/HFS+, other file systems and formatted (initialized) drives. It is a professional, but extremely simple, Mac data
recovery software that helps rescue data
on Mac disks, external or internal hard
drives, memory cards, cameras, iPods
Classic, and others. The usual price of
$89 has been reduced to only $62 for this
limited-time user group offer. Coupon
code:
Recover your
files now: http://www.cleverfiles.com/ This
offer is valid through April 1, 2012.

software development for Mac users. All
flashers will see the true value of Flash Decompiler Trillix for Mac, Flash Optimizer
for Mac and SWF & FLV Player for Mac.
With these products, managing Flash files
is easy: decompile, compress or just play
them back. Regular prices for Eltima’s
Flash software range from $19.95- $99.95.
Using the coupon code gives user group
members 20% off. Get your Flash products here: http://mac.eltima.com/ Coupon
code:

Mac|Life is THE Apple-product magazine that changes all the rules. Mac|Life
recognizes Apple’s dynamic role in work,
play and life and will appeal to core Apple
users. With fresh insight, in-depth howtos, stunning design and exclusive information, Mac|Life helps users realize their
full potential. Mac|Life is the ultimate
magazine about all things Apple. Mac|Life
is offering a Apple user group member
subscription rate of $17.95 for 12 issues,
a savings of 75% off the basic subscription
price. Subscribe today: http://www.maclife.com/mugsub

Freeway gives you all the legendary easeof-use and features that launched the
desktop publishing revolution. You can
quickly and effortlessly lay out your website, embed images and content, then
publish your work as standards-compliant HTML. Upload to your server, MobileMe or to a folder. You supply the creativity, Freeway handles the code. LIMac
members can buy Freeway Pro, regularly
$249 for $186.75, and Freeway Express for
$59.25, a 25% discount. Build your website now. http://www.softpress.com/store
Promo code:

Get 40% off books and videos from
O’Reilly, Microsoft Press, No Starch,
Paraglyph, PC Publishing, Pragmatic Bookshelf, Rocky Nook, SitePoint,
or YoungJin books and 50% off ebooks
you purchase directly from O’Reilly. Order from the O’Reilly Store online or by
phone at 1-800-998-9938. http://www.
oreilly.com/store/ Online Code:

PowerMax.com, the engine behind The
Apple MUG Store, is pleased to announce
a new process for Apple user group members. Instead of going to the Apple MUG
Store website to view a limited selection
of items, members can now go directly to
the PowerMax website to peruse and purchase almost 50,000 products. By identifying the user group you belong to (either
on an online order or over the phone),
PowerMax will continue to accumulate
points for LIMac to use. In addition to

Eltima Software is a global software development company, specializing in Flash

User Group Offers continued on Page 8
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Bradley’s Tech Session continued from Page 4

don’t have a G5, just a G4, so you can’t
use that either. So iMovie HD v6.0.3 is as
good as it gets for you. It only supports
direct HDV capture from a tape based unit
via FireWire. If you have some other video
camera, you would have to save the video
from that to your hard drive, convert it
to something iMovie likes and then edit
from there. MPEG-4 files or HDV 720p
or HDV 1080i would work. You could try
the $120 Sanyo Xacti VPC-CG10 which is
a tiny thing that shoots a 720p MPEG-4
video file onto a SDHC card (up to 32GB
or almost 8 hours) The HD-SHQ mode
is 9Mbps (1280x720) It has a 5x optical
zoom. The Canon VIXIA HV30 is an older
miniDV HDV format camcorder that got
good reviews that should also work well
with iMovie HD 6 but at $825, a much
higher priced alternative. Generally the
modern camcorders store the video in
AVCHD format that requires an Intel processor to handle. You could go the other
way, buy a modern product and convert
the files for editing in iMovie HD. You will
need Shedworx’s $40 VoltaicHD. Then you
could look at this list of AVCHD cameras.
Which brings me to a final suggestion,
don’t buy a camcorder, but a camera that
also does video. The Canon PowerShot
SX200 IS saves it’s 720p movies in good
old Apple’s QuickTime .mov format, perfect for iMovie HD 6 use. And you can
shoot 12.1 megapixel still with it as well.
I see it new for $235 at buydig.com

| Sometimes on my Intel iMac it says my
wireless keyboard is not discoverable?
■ Of course it’s possible the batteries in the
keyboard are weak. Sometimes the blue-

User Group Offers continued from Page 7

tooth settings get a little messed up. I’d go
to the System Preferences - Keyboard and
first check the battery life percentage, then
click Show All button and then Bluetooth,
highlight the keyboard, click the minus
sign at the bottom and then the plus sign
to re-add the keyboard. That brings up the
Bluetooth Setup Assistant. You may have to
press the button on the right side of the
keyboard to wake it up and make it discoverable as indicated by the blinking LED on
the top-right of the keyboard.

| I recently updated the Java on my Mac

and now the web site I use to upload pictures tells me that Java is not enabled but
I can see it is, in Firefox’s preferences? It
works in Safari. Why?
■ This sort of thing happens all the time.
A web site looks for a resource of some
discrete version and not some version or
newer. Thus when there is a new verion
out there, the web site doesn’t find the
version it wants to see and assumes you
don’t have any Java or it’s turned off. You
can delete the new java from /System/
Library/and the receipt, download and
install the previous java and go with that
until they update their website. This is a
little outdated, but may help: http://www.
servoymagazine.com/home/2010/06/tutorials-how-to-downgrade-java-on-a-mac.
html Time Machine backups are great for
this kind of problem too. As for Safari
versus Firefox, Safari uses the WebKit
layout engine and Firefox does not. It
uses Gecko. 0
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great deals, free UPS shipping is offered
on any order over $50. Be sure to take advantage of this win/win deal: http://PowerMax.com
RadTech manufactures and distributes
an array of best-in-class accessory solutions for Apple computers, iPhone, iPod
and Cinema Displays, all designed to keep
you connected and protected in style. Experience the RadTech difference through
their unique product line and legendary
customer support. LIMac members get
20% off all products. Start saving now:
http://www.radtech.us Discount Code:
Apple user group members receive a 35%
discount when they shop at peachpit.com.
Just enter the user group discount coupon code at checkout. Ground shipping
is free! (This discount cannot be used in
conjunction with any other coupon codes
such as the Peachpit Club.) http://www.
peachpit.com Coupon Code:
No matter what Apple devices you’re
using, there’s a Take Control ebook
that will help you polish your skills, work
more efficiently, and increase your productivity. Check out our highly practical, tightly focused ebooks covering Mac
OS X, Macintosh applications, the iPad
and iPhone, 802.11n networking, and
more! Written by the most-trusted names
in the Mac world and published by Adam
and Tonya Engst of TidBITS, Take Control ebooks provide the technical help you
need now. Take Control ebooks are available for immediate download in PDF forAUGUST
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mat (for Macs and iPads), and with EPUB
(for iPhone and iPod touch) and Mobipocket (for Kindle) versions available after purchase. An exclusive 30% off their
already low prices is offered to Apple user
group members on all Take Control ebooks. Purchase Take Control books at a
discount with this coupon-code-loaded URL:
TidBITS: http://www.tidbits.com
Do you own or work in a Mac-based small
business that has grown out of it’s computerized checkbook? Have you grown
tired of creating invoices using InDesign or Word? If you think you are ready
to move beyond your shoebox, MYOB
has the right tool for you at a great MUG
discount. MYOB, Inc., the leader in Mac
small business management, has just released MYOB FirstEdge, a new Mac only
product that will help you run your business quickly and easily. MUG members get $25 off the regular price of $99
on FirstEdge or $100 off AccountEdge.
http://www.myob.com/us/ 0

August Meeting continued from Page 2

July Meeting continued from Page 5

Screen Shot-7

“Smile” (formally called “Smile on My Mac”) is a supporter of LIMac, and
I have found all of their products to be of high quality and very useful. You
can buy PDFpen or PDFpenPro from their website (http://smilesoftware.com/)
for $59.95 and $99.95 respectively. You can give them a try at no cost, by
downloading the fully functional demo. This demo does not expire, but leaves
a watermark on the pages. You can see for yourself if PDFpen’s features will fit
your needs. Many thanks to “Smile” for their continued support of LIMac.

Software that’s Just Right.
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under Lion. Same thing for many, many
other programs. I’ve seen many updates
for Lion compatibility, mostly the smaller
programs we all love. The more complex
will take longer. I’d strongly suggest looking at roaringapps.com and your various
developer’s web sites for any Lion related
news. The situation will get better in time
as more updates come out. Of course if you
buy a new Mac with Lion pre-installed, you
could be out of luck. For example, there are
problems with Adobe Creative Suite programs under Lion, most minor as long as
Crash Reporter isn’t involved. See this support document from them: http://kb2.adobe.com/cps/905/cpsid_90508.html Besides applications not working in the 64-bit world
of Snow Leopard, assorted plug-ins for other
applications will stop working and will require an update. I use Cosmopod from Cocoamug software. It’s already broke under
Snow Leopard because of Safari 5.1. OnOne Software makes a popular suite of Photoshop plugin. You should read this before upgrading to Lion, including the user
comments: http://www.ononesoftware.com/
blog/2011/07/13/read-this-before-you-upgrade-to-mac-os-x-lion/
Another example, in a better situation,
is Letter Opener, a handy plug-in (Bundle)
for use in Apple’s Mail. It adds the ability
to see the contents of winmail.dat archives
from a Windows’ Outlook sent message.
They just released a new paid version, version 4.0, that works in Lion’s new version
of Mail. Still a $15 upgrade fee, instead of a
free patch, but at least they offer a solution.
Then there a problems I’ve been reading, like it needs more memory than Snow
Leopard, 2GB becomes essentially unusable
AUGUST
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and 4 is the minimum, and it really wants
8GB. Which is a problem if your model
can’t be upgraded beyond 2GB. As a side
effect of this, your Mac with say 3GB which
was fine before, now runs much slower
than before. I’ve read where the Mac runs
hot now. I’ve read reports from folks who
can no longer scan, as their driver was PowerPC. They have to buy either a new scanner or use VueScan Pro, which is about as
much money as a new scanner. ABBYY FineReader Express Edition doesn’t work with
Lion even though it’s a Universal Binary appliction. FYI: VelOCRaptor 1.2 nor Readiris Pro 12 also don’t work yet. TechTool Pro
6.0.2 doesn’t work, but most of Drive Genius 3.1.1 does. I could go on, but there
are lots of reports of problems. At the very
least, make a list of your software and build
up a check list of what needs an update and
what should work. Eventually you’ll get to
a point where only unimportant programs
won’t work and you’ve converted your old
AppleWorks files and you can finally upgrade to Lion if you still want to. For me, I
wouldn’t suggest it until something really cool comes along that requires Lion, or
something wrong with Snow Leopard or
my Mac was resolved with an software update that was released for Lion exclusively.
Meanwhile my job requires me to make the
most of the computers purchased, so I have
to deal with Lion’s problems on a daily basis. I have a partial solution: I got a copy of
Mac OS X 10.4.11 running under VMware
Fusion 3.1.3 and can run the old PowerPC
programs there, as it has Rosetta.0

In June LIMac’s Vice President, George Canellis, attended the Consumer Electronics Association Line Show in New York City and the good people at the Mimoco booth were gracious enough to donate one of their 2GB Mimobot designer USB
flash drives to LIMac. Mimoco manufacturers USB flash drives in capacities up to
16GB in a variety of character designs; DC Comics, Star Wars, Hello Kitty and many
others. And every Mimobot comes preloaded with exclusive content; desktop graphics, rich media, music, digital magazine and much more. An ideal gift idea for the
geek in your life or get a few for the holidays as stocking stuffers or secret Santa gifts.
Visit Mimoco’s website to see their full product line. http://www.mimoco.com/

North

| In bad weather, call (516) 686-7789.
| The next LIMac board meeting will be at the Plainedge
Library, (516) 735-4133, on Wednsesday, August 17th,
at 7:30 p.m. For more detailed information about this
location go to limac.org

West

East

Renewal
South
General meeting time schedule:
Meetings are held at
The New York Institute of Technology,
Building 300 (Anna Rubin Hall),
Old Westbury, Long Island.
For more detailed information about this location go to
limac.org
Meetings start promptly at 7:00 p.m.
Bradley’s Q&A: 7:00 – 7:30 p.m.
MacBasics Q&A: 7:00 – 7:30 p.m.
Beginner Q&A meetings
Photoshop SIG: After general meeting
On Vacation
Featured Presentation: 7:30 – 8:20 p.m.
followed by announcements and rafﬂe drawings.
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Send your $36 check to:

SPECIAL NOTICE
This edition is made for viewing on your computer
screen. If you want to print this version I have now
compensated for some printers that don’t print too
close to the edge, if however, you wish a more printer
friendly edition without all the colors just email me at
azygier@nyc.rr.com and I’ll be happy to send you one.
(Al Zygier)
•

AUGUST

How to better visually enjoy the Forum: Your Editor prefers
you to use Adobe Reader 9 as long as your Mac meets the
requirement of Mac OS 10.4.11 or newer. PostView 1.8 ($22)
works from Mac OS 10.2 all the way up to 10.5 for PowerPC
and Intel based Macs.

For a Year’s membership

Mac Basics
On Vacation

Photo of last month’s winner of a 2GB Joker Mimobot USB flash drive.

Membership renewal for 2011 takes place from October onwards. A
bonus discount was passed by the Board of Directors a few years ago:
Bring in a new dues-paying member and get a $12 discount off your
membership renewal. Bring in three new members and your renewal
is free!
Bringing in a new member also includes getting a past member
back into the group.
Make your $36 check out to LIMac and bring it to the next meeting,
or mail to LIMac, Post Office Box 2048, Seaford NY 11783-0180
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